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Document Overview 

 

This document constitutes a formal statement of the USER MANUAL for DATA 
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Amendment Log 



DADF             18th Livestock Census  

User Manual for Data Entry ï Detailed House Hold wise Ver 1.0  

3 Of   119 

 

 

Version 

Number 

Date Change 

Number 

Brief 

Description 

Section 

Changed 

1.0 13/01/2009 - User Manual - 

2.0 06/05/2010  User Manual Added 

Tabulation 

Planôs Report 

           2.1     30/07/2010   User Manual Added status of 

states having 

and not having 

their livestock 

and poultry 

data. 

           2.2    13/08/2010   User Manual Added 

comparison 

between quick 

and detail data. 

 

 

Note: - For this version of software kindly use SQL Server 2005 instead of SQL Server 2000. You can 

download the manual for installing Sql server 2005 from departmental website. 
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1 .0    I ntroduction  
 

India has conducted 18 Livestock Census s o far. NIC was associated in 17 th Livestock 
Census to publish Dist rict wise data o n the website of the Department of Animal 

Husbandry Dairying and Fisheries (http://dadf.gov.in). Major Guidelines for 
conducting that Census were also published.  

 

This is first time the Government of India has decided to preserve the househ old 
information on Livestock Census in database form. The number of records thus 

generated will be as follows:  
 

 Village level data on Infrastructure ~ 0.6 m records  
 Village level data on AH & Poultry (Quick results) ~ 0.6 m records  

 Household data for all t he parameters enumerated ~ 140 m records  
 

If somebody requires analyzing  the development in AH sector based on the 
information generated on the past Censuses, it may not be possible to process the 

information using present day IT tolls  such as Data Warehou sing and Data Mining 
technologies .   

 

2.0   Hardware and Software Requirements  
 

From such a large database to extract village, Sub -district, District, State a nd National 
level information , it is necessary that a sufficiently stable database is chosen to en ter 

the data. For this purpose we have chosen    SQL Server 2000.  
 

The software has been developed to work on client server co nfiguration. Detailed data 
entry is to be carried out on the same infrastructure  or at least district wise data 

entry.  

 
2.1 Hard ware  requirement  

 
Minimum Hardware requirement to enter the data is as follows:  

 
a)  One Server with Windows XP/ Windows 2000 server  environment. ïMinimum 1  

GB RAMS. Server ( preferably 2GB RAM), Clients  ( preferably 1GBRAM)  
b)  Clients Windows XP/ Windows 2000 en vironment  -  Minimum 512 MB  RAM. 

Number of clients will depend on the number of data entry operators  engaged in 
the data entry work ( 128 MB X No of Clients )  
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c)  LAN configured environment.  Local LAN for simultaneous data entry through 

Clients & Server  
 

 
 

 
2 .2   Software requirement:  

 
2.2.1 On  Server side  

 
1.  SQL Server 200 5    

 
Note: -  You can download the manual for installing S QL Server 2005 from department 

website, http://dahd.nic.in/LStock.htm , under link óC6ô 

 
2.   Internet Information Server 5.1  

(Control  Panel ->IIS ->Help ->  About)  
 

3.   Internet Explorer   7.0  
(Internet Explorer -> Help -> About)  

 
4.   .NET framework 2.0  

(To determine which versions of the .NET Framework are installed on a computer, follow t hese steps:  

1.  Search  the Mscorlib.dll file  

2.  Right -click the Mscorlib.dll file, and then click Properties .  

3.  Click the Version  tab,  note the file version should be  v2.0.50727  

4.  v2.0.50727  .NET  Framework is  available with CD and on http://dadf.gov.in  

5.    Install ñWindows Installer Package ï Crystal Reports for .NET Framework 2.0(x86) 

(CRRedist2005_x86.msi)ò from department website, http://dahd.nic.in/lstock.htm , 

under link óC8ô. 

6.  Install ñWindows Installer Package ï Microsoft ASP.NET 2.0 AJAX Extensions 1.0 

(ASPAJAXExtSetup.msi)ò from department website, http://dahd.nic.in/lstock.htm , 

under link óC9ô. 

 7.  Screen Resolution 1024X76 8 (TFT  Wide screen may differ)   

 (Internet  Explorer ->View ->Text Size -> Medium)   

 

http://dahd.nic.in/LStock.htm
http://dadf.gov.in/
http://dahd.nic.in/lstock.htm
http://dahd.nic.in/lstock.htm
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The Software is rigorously tested on Win XP Professional with SP2 and with SP3 also.  

 
 

 
 

 
2.2.2 on  Client Side   

 
1.  Internet Explorer   7.0  

 
2.  Screen Resolution 1024X768 (TFT Wide screen may differ)   

 
 

  3.0   Changing the name of Server  
 

  Right click on My Computer  on  Desktop  
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3.1 Click  on Properties  
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3.2  Click on Network Identification , then click on Properties  
 

 
 

 
 

 
 

 
 

 
 

 
 

 



DADF             18th Livestock Census  

User Manual for Data Entry ï Detailed House Hold wise Ver 1.0  

10 Of   119 

 

 

 
 

 
 

 
3.3  Change t he computer name as  ñserver dadf ò then click ok . ( Note : -  If your 

computer  name is already ñserverdadfò then no need to change the name of 
computer.)  
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4.0    Enable Auto  Hide  to  see lower portion of the screen  

 
 Click Taskbar as shown in the screen  
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4.1     Now Click on Properties , then Click on ñAuto hideò option,  then click on Ok  
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5 .0 . To Restore  backup in SQL Server  200 5  
 

For this part (for creation and restoration of lstockhh database), kindly d ownload 
manual from department website http://dahd.nic.in/lstock.htm , under heading ñC6ò 

 
 

Note: -Backup is to be restored only once , data will be lost if installed second time on 
the same system.  In Client / S erver Architecture,  data will be saved at one place 

(serverdadf ) only .  
 

 

6.0  To  install or verify the presence of Internet Information Server  

 

Internet Information Server (IIS) is preinstalled on almost all machine and all platforms.  It may be 

verified whether IIS is installed  on now IIS on your server machine by clicking on 

Start>Settings>Control Panel>Add/Remove Programs under Add/Remove Programs,  there is option 

Add/Remove Windows Components on the left side click on this option and follow the steps your IIS 

will get installed 

 

This step requires Windows XP SP2 installation CD  

One may check about IIS to Start>Settings>Control Panel>Administrative Tools and presence of Internet 

Information Services  

 

 
 

http://dahd.nic.in/lstock.htm
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7.0 To  Install Detail Data Entry Software  for household   

 

After this install, the application software ï Detailed Household Data entry module. The steps to install 

the software are as follows: 

 

1. Open CD drive, there is one folder named   

 

Household Software ->  òlivestockhhò  ->    then click on ñDebugò folder  

 

 
 

Note: - If you have installed previous version, then kindly uninstall the software first  

By Start->Setting->Control Panel ->Add Remove Programs -> Livestockhh  

 

And remove  
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Start ->Setting -> Control Panel -> Administrative Tools -> IIS -> Web Sites -> Default Web Sites  -> 

Livestockhh   

                       

 

 

7.1 Click on ñSetupò icon as shown below 
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7.2   Following screen appears Click Next  
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7.3Click on Next 
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7.4  ClicK Next  -> Close  
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8.0 Configuration of   IIS  

 

Start -> Setting -> Control Panel -> Administrative Tools -> IIS   -> Web Sites -> Default Web Site -

>livestockhh  

 

Right Click livestockhh -> Properties ->Documents -> Add  

 

Enter login.aspx and Click OK  
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8.1   IIS Configuration, Run a program  

 

(a) Run a program :-ñ%windir%\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe ïi 

Where %wiindir% is c:\windows in most of the cases, otherwise working directory of windows.  Take 

care of the version. 

(b) Also, Start -> Setting -> Control Panel -> Administrative Tools -> Websites -> Default Website -

> Livestockhh      

Right Click Livestockhh -> Properties -> ASP .NET ï 

If Enabled select the version to v2.0.50727  

If Disabled leave as it is  
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(c)  Click the ñEdit Configurationò button shown in above screen, the following screen appears:- 

 

 
 

Here, select ñState Managementò Tab, the following screen appears:- 

 
 
Here, select ñInProcò option for óSession state modeô 
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9.0 How  to Use the Software  
 

STEP ï I  
 
Open internet explorer. In the address bar type the path 

http://serverdadf/livestockhh/login.aspx . The form shown blow will appear  

 

(1)  Login Form:   

 
 Enter your user name.  

 Enter your password. 

 

After entering valid username and password the screen below will appear. It is noted that only admin 

can add new user.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tahsil and Village can be added only for Rural Category and only by admin user. 

Town and Ward can be added only for Urban Category and only by admin user. 

http://serverdadf/livestockhh/login.aspx
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(2) State  Form  

 

 Enter the state code in the corresponding text box.   

 Enter district code of the district whose state code is entered.  ( 01 to Number of Districts) 

 Select the area type whose data is to be entered (Rural or Urban). 

 Enter Tehsil Code and Village Code in Case of Rural or Enter Town Code and Ward code in case 

of  Urban 

 Then enter total no. of household having household 

 Then Click on submit. 

 

If you login as administrators (admin) add options for village, ward, user and data entry options will 

appear as follows:  
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(3)    If  you login as a non admin user, the following screen appears (note the absence of Add Tehsil and 

Add Village,  

 

 

 
 

 

For a smooth data entry, It is advised that  

 

First, district wise user may be added.  Data related to one district should not be on different LAN 

locations or different serverdadf. It can be on different computers on same LAN 

Second, finalize the list of   Districts.  

Third, finalize the list of subdistricts and villages.  

Fourth, finalize the list of towns and wards.  

No Record can be added or modified in Breed List and State List  

 

A Detailed guideline on ????  is also provided with this Software CD regarding PLCN code of state , 

District , Subdistrict  , towns and wards. It has been observed that village exists without subdistricts  and 

wards exists without  town which gives discrepancy in data. Only recoganised breed can be entered.   A 

write up on PLCN Code ???? is also included in the CD  
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(4) If your Tahsil is not there you can add Tahsil by clicking on ñAdd Tahsilò option, this facility is for 

admin user only and available only for Rural. Add Town and Ward is available to urban   area only.  
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(5) If your Village is not there you can add Village by clicking on ñAdd Villageò option. This facility is 

for admin user only and can not be entered without Tehsil Code.  
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(6)   If your Town is not there you can add Town by clicking on ñAdd Townò option (this facility is for 

admin user only) 
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(7)   If your ward is not there you can add Ward by clicking on ñAdd Wardò option (this facility is for 

admin user only) 
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STEP ï I I  

 

(1) House Hold data Entry -First click on ñAdd Householdò option. The screen shown below will appear 

for Household. Enter the valid household number and then click on ñCheckò button. (User has to enter 

Household first before doing the livestock dataentry.  Reason ,if household entry is not there user will 

not able to do dataentry. 
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(2)     If this particular household number is not there in database, the screen shown above will appear. 

All the fields are mandatory (cannot leave blank). Entry for each field can be viewed with the ñHelpò 

button given on the top. After entering the complete data click on ñSubmitò button to save the record.  
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(3)     If  Household number already exist message will be displayed that ñHousehold number already 

exist do you want to update or deleteò .The screen shown below will be displayed.  

 

You can make the changes and update it by clicking on ñUpdateò button. If you want to delete the record 

click on ñDeleteò button.   
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STEP ï I II  

 

Data Entry of 

(1) Species (Part -I) - Clicking ñData entry ñfollow ing screen will appear. (XML for server only option is 

for server machine only, it will not appear on client machine. It is for generating and restoring of data 

from server machine only) 

 

 
 

The above Data entry Screen is divided into five Parts 

 

 Part-I contains the 15 Livestock species 

 Part-II  (A) contains Backyard Poultry(Fowls, Ducks, Turkey/Quails/Other birds) 

 Part-II  (B) contains Poultry Farms 

 Part-III  Agricultural Implements & Equipments 

 Part-IV  Fisheries Statistics-I and Fisheries Statistics-II  

 Part V Village Profile 
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(1.1)    Data Entry Livestock: - By clicking on each link the respective screen will appear. For example: 

on Clicking ñCattle specieò, the Cattle screen will appear as shown below. The cursor will blink in 

ñHousehold Sr No.  text boxò enter the household number and then click on Check button to 

verify whether data exists for cattle in the village or ward.  
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(1.2)   If the household number is correct, the screen below will appear and if the household number is 

incorrect the messageò Household number does not exist will appearò 

 

 After entering the correct species and breed code textboxes for entering data will appear on the 

screen. 

 As soon as the user enters data, to see the  sum , click   Show Sum   Button to verify the sum 

displayed in the textbox with heading total. 

 If user enters data in incorrect format a message ó Enter correct valueô will flash. 

 After entering data click submit. Data will be saved in the database and a message ñData Entered.ò 

will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. If the record already exists for any breed the data will be shown in the respective       textboxes as 

follows: 
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(1.3) If  the record already exists for any breed, the data, already entered, will be shown in the respective 

textboxes as follows: 

 

 Button for update and delete will appear. 

 If user wants to change the data he can correct it and then press ñUpdateò the changes will be 

saved in the database. 

 To delete the record click on ñDeleteò button. 

 To cancel the selection press ñCancelò button. Textbox for data editing will disappear. 

 To see the total of Male and Female breed click Sow sum option 

 Back Button is used to go back to previous screen 

 Home Button is used to go to Login screen 

 Logout is used to close the application  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

          Similarly, you can enter the data for other species. 
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(1.4) By clicking on ñShow Checklistò option on the top you can see the list of data entered     for a 

particular village or ward, and for particular species (all breed). Hide checklist button is to hide the 

checklist for proper viewing. If problem comes then verify Auto Hide option.  
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(1.5) ñSave Checklist in W ord ñis to save your check list in word format, screen shown below will appear 

click on save option. Kindly note that all download program such as getright , DAP , IEPRO7  should be 

disabled .  Save Checklist button is enabled only after show button is enabled and if only data is available 

for that species in the village or ward , Town or Sub District , District and State.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



DADF             18th Livestock Census  

User Manual for Data Entry ï Detailed House Hold wise Ver 1.0  

38 Of   119 

 

 

(1.6) Select the desired location to save a word file with the name given in files option, click on save 

option.  The name of the file will be State, District Na, Tehsil Name, Village Name and species.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now you can check your Excel file at location where you saved the file 
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(2) Poultry (Part ï II)   Same procedure is to be followed for poultry  items such as Fowls , Ducks and 

Turkeys, Quails and other Birds ,   In ñType of Poultry Farmsò,  if you enter 1,layer is enabled and all 

other boxes are disabled, in case of 2 ,Broilers are enabled and other boxes are disabled. In case of 3, 

Duck and Others are enabled, Layers and Broilers disabled.  
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(3) Agriculture Implements and Machinery (Part ï III ) Same Procedure is to be followed by Part ï III.  

Note that scroll button for viewing complete screen.  
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(4) Fisheries Statistics ï I and 2 (Part ï IV   ) Same Procedure is to be followed by Part ï IV.  Note that 

vertical as well as horizontal scroll button for viewing complete screen.  In case of   problem regarding 

code, help is available onscreen 
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(5) Village Profile (Part ï V -) Same Procedure is to be followed by Part ï V.  Note that vertical as well as 

horizontal scroll button for viewing complete screen.  In case of   problem regarding code, help is 

available onscreen. Before entering data. Check whether data is available for that village or ward or not.   

For all those states, who have entered data for that screen at quick level, not required to enter this data.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note that Village Profile check list and status of village profile data is available on Master Report Screen 

for viewing and saving from State Data Entry Form. 

 

 

 

 


